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Task 6 &

From the desktop, open the NYC
Property Transactions workboolk.

‘You need to record the performance of
the Property Transactions dashboard in
the NYC Property Transactions.twbx
workbook, Ensure that you start the
recording as soon as you open the
workbook, Open the Property
Transactions dashboard, reset the filters
on the dashboard to show all values, and
stop the recarding. Save the recording in
CACC\Data\,

Create a new worksheet in the
performance recording. In the worksheet,
create a bar chart to show the elapsed
time of each command name by
worksheet, to show how each sheet in
the Property Transactions dashboard
contributes to the overall load time.

From the File menu in Tableau Desktop,
click Save. Save the performance
recording in CACC\Datah,

P.S. Free 2026 Salesforce Analytics-Con-301 dumps are available on Google Drive shared by ValidDumps:
https/drive.google.comvopen?id=1mDITYCaSL8 SmYYSoeUismDzUEem3jFk

The Salesforce Certified Tableau Consultant Analytics-Con-301 Questions lead to Salesforce Analytics-Con-301 certification. The
Analytics-Con-301 certification is for anyone new to the industry. Whether you have just graduated from college, making a career
change, already working in the sector, or searching for new ways to progress, the Salesforce Analytics-Con-301 Certification is
ideal for you. If you want to appear in the Analytics-Con-301 test of Salesforce Analytics-Con-301 certification, you should have
basic hands-on experience.

Our Analytics-Con-301 exam dumps are possessed with high quality which is second to none. Just as what have been reflected in
the statistics, the pass rate for those who have chosen our Analytics-Con-301 exam guide is as high as 99%. In addition, our
Analytics-Con-301 test prep is renowned for free renewal in the whole year. With our Analytics-Con-301 Training Materials, you


https://drive.google.com/open?id=1mDITYCaSL8_SmYYSoeUismDzUEem3jFk
https://www.practicevce.com/Salesforce/Analytics-Con-301-practice-exam-dumps.html
https://www.pdfdumps.com/Analytics-Con-301-valid-exam.html

will find that not only you can pass and get your certification easily, but also your future is obvious bright. Our Analytics-Con-301
training guide is worthy to buy.

>> Interactive Analytics-Con-301 Questions <<

Pass Guaranteed Pass-Sure Salesforce - Interactive Analytics-Con-301
Questions

Are you planning to attempt the Salesforce Analytics-Con-301 certification exam and don't know where to study for it and pass it
with good marks? ValidDumps has designed the Salesforce Certified Tableau Consultant (Analytics-Con-301) Questions, especially
for the students who want to pass the Analytics-Con-301 Certification Exam with good marks in a short time. These Salesforce
Certified Tableau Consultant (Analytics-Con-301) practice test questions are available in three different formats that you can carry
with you anywhere and even do preparation in extra or free time with ease.

Salesforce Certified Tableau Consultant Sample Questions (Q36-Q41):

NEW QUESTION # 36

A multi-national company wants to have a Tableau dashboard that will provide country-level information for both its forecast
summaries and year-on-year metrics. The company wants to toggle between these two views while leaving main key performance
indicators (KPIs) visible on the main dashboard.

Which method is the most efficient in achieving the company's requirements?

e A Create a dashboard with the sheets containing the main KPIs and the forecast summary worksheet.
. Duplicate this dashboard and replace the forecast view worksheet with the year-on-year metrics worksheet.
. Add navigation buttons to both dashboards.
¢ B. Create a parameter that accepts values froma list that contains "Forecast View" and "Year-on-Year View."
. Right-click the parameter and select Add to Sheet for both worksheets.
. Navigate back to the dashboard and to the upper corner of the two worksheets.
. Enable the Use as Filter option.
¢ (. Create a Boolean parameter with the two names of'the views as aliases and a corresponding calculated field with the
following calculation: True.
. Add the forecast summary sheet to the dashboard and add the year-on-year metrics sheet to the same dashboard as a
Floating dashboard object.
. Add the calculated fields as a Detail under the Marks card of the floating view, create a "Change Parameter” action, and set
the
"Target Parameter" and "Source Fields" to the parameter and calculated field you created.
. Check the box for "Control visibility using value" in the Layout tab of the floating view and select the parameter you created.
¢ D. Create a single worksheet with all the measures required for both the forecast summary and the year-on- year views.
. Create a Boolean parameter and a corresponding calculated field with the following calculation: True.
. Add a blank dashboard object and in the Layout tab, check the box for "Control visibility using value" and select the
parameter you created.

Answer: C

Explanation:

The most efficient method for toggling between two views (forecast summaries and year-on-year metrics) while keeping main KPIs
visible involves using a parameter and calculated fields for controlling visibility:

* Create a Boolean Parameter: This parameter will have two aliases representing the two views ("Forecast View" and "Year-on-
Year View"). This allows the user to select which view they wish to see directly from the dashboard.

* Calculated Field: Create a calculated field that always returns True. This field acts as a constant placeholder to enable the visibility
control tied to the parameter.

* Dashboard Setup: Place both the forecast summary and the year-on-year metrics sheets on the dashboard. Set the year-on-year
metrics sheet as a floating object over the forecast summary.

* Visibility Control: Use the "Control visibility using value" option in the Layout tab for the floating year-on-year metrics view. Tie
this setting to the Boolean parameter so that changing the parameter will show or hide this view without affecting the main KPIs
displayed on the dashboard.

* Interactivity: Implement a "Change Parameter" dashboard action where selecting different options in the dashboard (e.g., clicking
on certain parts) triggers the parameter to change, thus toggling the visible view.
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This method leverages Tableau's dashboard interactivity features including parameters, calculated fields, and visibility settings, as
recommended in Tableau's user guide on dynamic dashboard design.

NEW QUESTION # 37
A client calculates the percent of total sales for a particular region compared to all regions.

‘Which calculation will fix the automatic recalculation on the % of total field?

sum([Sales])}

sum([Sales])}/{FIXED :SUM([Sales])
sum([Sales]) }/SUM([Sales]}
[Sales]}/{FIXED: SUM([Sales])}

A. {FIXED [Region
B. {FIXED [Region
C. {FIXED [Region
D. {FIXED [Region
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Answer: C

Explanation:

To correctly calculate the percent of total sales for a particular region compared to all regions, and to ensure that the calculation does
not get inadvertently recalculated with each region filter application, the recommended calculation is:

{FIXED [Region]: sum([Sales])} : This part of the formula computes the sum of sales for each region, regardless of any filters applied
to the view. It uses a Level of Detail expression to fix the sum of sales to each region, ensuring that filtering by regions won't affect
the calculated value.

SUM([Sales]): This part computes the total sum of sales across all regions and is recalculated dynamically based on the filters
applied to other parts of the dashboard or worksheet.

Combining the two parts: By dividing the fixed regional sales by the total sales, we get the proportion of sales for each region as
compared to the total. This calculation ensures that while the denommator adjusts according to filters, the numerator remains fixed
for each region, accurately reflecting the sales percentage without being affected by the region filter directly.
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This calculation follows Tableau's best practices for using Level of Detail expressions to manage computation granularity in the
presence of dashboard filters, as outlined in the Tableau User Guide and official Tableau training materials.

NEW QUESTION # 38

A company's Tableau Cloud admin wants to maintain control over what content gets published to its site for viewers, while also
supporting self-service for dashboard creators.

Which governance strategy should the admin implement?

A. Restrict users' permission to view data sources used in uncertified dashboards.

B. Allow dashboard creators to publish to their Personal Space and for site administrators to move content to projects.
C. Maintain a separate sandbox site and use the Content Migration Tool to promote content between sites.

D. Create sandbox projects to contain ad hoc content and production projects for validated content.

Answer: D

Explanation:

Comprehensive and Detailed Explanation From Exact Extract:

Tableau's recommended content governance model for Server and Cloud emphasizes project-based separation between
development ("sandbox") content and certified, production-ready content.

Key points from Tableau governance guidance:

* Organizations should define sandbox projects where creators can fieely publish and iterate on workbooks and data sources.
* Once content is reviewed and validated, it is promoted into "production" projects that are designated for trusted content for
viewers.

* This model allows self-service authoring while keeping tight control over what is exposed to broad viewer audiences.
Option A exactly reflects this model: sandbox projects for ad hoc content, and production projects for validated content.
Option B uses separate sites and the Content Migration Tool, which is heavier to manage and usually reserved for cross-
environment moves (such as dev to prod), not necessary for basic project-level governance in a single Tableau Cloud site.
Option C relies on Personal Space. Tableau recommends Personal Space for private drafts, not as the main promotion path, and it
is not the primary governance pattern for viewer-facing content.

Option D restricts data source viewing but does not provide a full governance strategy for managing ad hoc versus production
dashboards.

Therefore, the correct strategy is sandbox projects plus production projects, which is option A.

* Tableau governance whitepapers describing sandbox versus production projects as a best-practice pattern.



* Tableau Cloud site administration guidance recommending project structure for self-service and controlled promotion of content.

NEW QUESTION # 39

A consultant wants to improve the performance of reports by moving calculations to the data layer and materializing them in the
extract.

Which type of calculation is the consultant able to move?

A. A row-level calculation

B. A calculation that contains parameters

C. A calculation that contains table calculation functions
D. A calculation that contains an aggregation

Answer: A

Explanation:

Comprehensive and Detailed Explanation From Exact Extract:

Tableau allows certain calculations to be materialized in extracts, meaning they are precomputed and stored nside the .hyper file to
improve performance.

According to Tableau's extract documentation:

* Materializable calculations must be compatible with the extract engine and must not depend on dynamic, view-based, or post-
query logic.

* Only row-level calculations and aggregation-level calculations without dependencies on runtime context can be materialized.

* Tableau cannot materialize any calculation containing;

* Table calculation functions

* Functions requiring post-aggregation logic

* View-dependent elements

* Parameters that need runtime evaluation

Evaluation of the choices:

A). A row-level calculation - Correct

Row-level calculations operate on each record individually before aggregation.

Tableau documentation specifies that these calculations can be pushed down into the extract and materialized because they do not
depend on the visualization or user interaction.

Exanples include concatenation, arithimetic, string manipulation, and row-based logic such as:

[Sales] * [Quantity] or IF [Region] = "West' THEN 1 END

These can be precomputed inside the extract, improving performance.

B). A calculation that contains table calculation finctions - Not allowed Table calculations (WINDOW_SUM, INDEX,
RUNNING _SUM, RANK, etc.) depend on the table structure after aggregation and query execution.

Therefore, Tableau documentation states they cannot be materialized in extracts.

C). A calculation that contains parameters - Not allowed

Parameters are evaluated at runtime, meaning the user can change their value.

Because of this, Tableau cannot permanently compute and store such a calculation inside an extract.

D). A calculation that contains an aggregation - Generally not materialized Aggregated calculations often depend on query context
and cannot always be materialized.

Only simple, context-free aggregations might be materialized, but Tableau explicitly warns that aggregations are not guaranteed
candidates for extract materialization.

Thus, this is not the best answer compared to row-level logic.

Conclusion

Only row-level calculations meet Tableau's exact requirements for materialization in extracts.

References From Tableau Consultant Documentation

* Tableau Extract documentation describing materializable calculation types.

* Tableau guidance stating table calculations and parameter-dependent calculations cannot be materialized.

* Extract optimization guidelines describing row-level logic as eligible for materialization.

NEW QUESTION # 40
A client calculates the percent of total sales for a particular region compared to all regions.

Which calculation will fix the automatic recalculation on the % of total field?

e A {FIXED [Regon]:sum([Sales])}



¢ B. {FIXED [Region]:sum([Sales])}/{FIXED :SUM([Sales])
¢ C. {FIXED [Region]:sum([Sales])}/SUM([Sales]}

e D. {FIXED [Region]{Sales]}/{FIXED: SUM([Sales])}
Answer: C

Explanation:

To correctly calculate the percent of total sales for a particular region compared to all regions, and to ensure that the calculation does
not get inadvertently recalculated with each region filter application, the recommended calculation is:

* {FIXED [Region]: sum([Sales])} : This part of the formula computes the sum of sales for each region, regardless of any filters
applied to the view. It uses a Level of Detail expression to fix the sum of sales to each region, ensuring that filtering by regions won't
affect the calculated value.

* SUM([Sales]): This part computes the total sum of sales across all regions and is recalculated dynamically based on the filters
applied to other parts of the dashboard or worksheet.

* Combining the two parts: By dividing the fixed regional sales by the total sales, we get the proportion of sales for each region as
compared to the total. This calculation ensures that while the denominator adjusts according to filters, the numerator remains fixed
for each region, accurately reflecting the sales percentage without being affected by the region filter directly.
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This calculation follows Tableau's best practices for using Level of Detail expressions to manage computation granularity in the
presence of dashboard filters, as outlined in the Tableau User Guide and official Tableau training materials.
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